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В качестве специфичных задач автоматизации железнодорожного транспорта можно отметить такие, как создание систем автоведения поезда, автоматизация сортировочных горок и др. Решение перечисленных задач невозможно без использования микропроцессорной техники. Поэтому выпускники железнодорожных вузов должны хорошо ориентироваться в вопросах, связанных с микропроцессорами: хорошо представлять каким образом функционирует микропроцессорная система, как организуется взаимодействие программных и аппаратных средств. 


В методических указаниях рассматриваются вопросы преобразования схемы в таблицу истинности.


Предназначены для студентов дневного курса обучения специальности «АТС» и других электротехнических специальностей, изучающих основы микропроцессорной техники и микропроцессорные системы управления.
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протокол №____ от "____"_________________2006г.


Лабораторная работа № 2


«Знакомство с EWB»


Цель: Знакомство с программой Electronics Workbehch. Проверка таблиц истинности базовых вентилей.





Краткое теоретическое введение.


Electronics Workbench канадской фирмы Interactive Image Technologies разработана достаточно давно и известны версии 3.0, 4.0, 4.1, 5.0, 5.12 Professional Edition. Программа непрерывно развивается, совершенствуется. Растет библиотека компонент, измерительных приборов, моделирующих функций. Версии 3.0, 4.0 были 16 разрядные, а начиная с Electronics Workbench 4.1 - 32-разрядные. И хотя в последней версии занимаемый объем на диске вырос с 1.4 Мбайт в версии 3.0 до 16 Мбайт в версии 5.12, однако эта программа остается одной из компактных программ (обычные требования подобных программ 80 -150 Мбайт). Во всех версиях остается неизменным (почти) дружественный интуитивный интерфейс, простой мощный графический редактор электрических схем, прекрасная интеграция с Windows системой. 


Программа Electronics Workbench 4.1 рассчитана для работы в среде Windows 3.xx или 95/98, а Electronics Workbench 5.0. – в среде Windows 95/98 и Windows NT 3.51. 


Этот пакет представляет законченную среду (shell) разработки электронных схем с интуитивным простым интерфейсом, близким для электронщика. Название пакету выбрано точно - в переводе - рабочий стол электронщика. 


У этого пакета имеется целый ряд достоинств, привлекающих внимание:


1. Оригинальный простой графический редактор, позволяющий достаточно просто рисовать на экране практически любые электронные схемы в привычном изображении.


2. Большая библиотека современных электронных компонент, дискретных, интегральных аналоговых, цифровых и смешанных аналогово-цифровых. Библиотека открытая, легко может пополняться новыми элементами, в том числе и отечественными.


3. Богатая библиотека электронных схем, позволяющая использовать готовые практические разработки и легко модернизировать под конкретную задачу. Библиотека открытая, позволяет производить пополнение, как за счет новых разработок, так и за счет подключения библиотек более ранних версий.


4. Великолепный набор виртуальных измерительных приборов, позволяющих выполнить любое электрическое (и не только электрическое измерение). Работа с этими измерительными приборами максимально приближена к работе с реальными приборами. Подключив виртуальный прибор к любой точке схемы можно получить исчерпывающую информацию о процессах в данном узле. 


5. Простой по интерфейсу набор моделирующих средств, позволяющий помимо традиционного моделирования электронной схемы по постоянному и переменному току, повести моделирование спектральных, нелинейных, амплитудно-частотных, фазо-частотных характеристик, влияние температуры на отдельные компоненты и на схему в целом, возможность сканирования (sweep) любых параметров компонентов, параметров источников сигналов и питания. Достаточно просто можно выполнить вероятностный анализ работы схемы с различными законами распределения параметров.


6. Большие возможности документирования исследования, получение твердой копии как электрической схемы, параметров моделирования, информации с экрана измерительной аппаратуры, хорошо оформленных графических результатов исследования.


7. Поразительно низкие требования, предъявляемые к компьютеру. Возможна работа начиная с 386 модели. 


8. Не требует знаний по программированию. Требуется лишь знакомство со средой Windows. Интуитивный интерфейс позволяет быстро даже неподготовленному пользователю (буквально за полчаса) познакомится с основами и приступить непосредственно к электронным исследованиям.


9. Нельзя не упомянуть обширный, тщательно подготовленный Help, обеспечивающий  как контекстную помощь по меню, компонентам, опциям моделирования, так и общие вопросы моделирования, возможные ошибки.


Достоинств в этом пакете больше, чем перечислено и о них еще будет говориться в процессе разработки лабораторного практикума. Однако то, что перечислено, позволило среди множества известных пакетов электронных CAD'ов (Computer Aided Design) выбрать именно Electronics Workbench как наиболее подходящий для использования в лабораторном практикуме.


Экран программы Electronics Workbench, показанный на (рис.2.1), напоминает рабочий стол регулировщика аппаратуры, что вполне соответствует названию (Electronics Workbench - дословно - рабочий стол электронщика). В отличие от  других программ схемотехнического моделирования, на нем изображаются измерительные приборы с органами управления, максимально приближенными к реальности. Пользователю не надо изучать довольно абстрактные (хотя и не очень сложные) правила составления заданий на моделирование.


Достаточно в схему ввести двухканальный осциллограф и генератор сигналов – и программа сама сообразит, что нужно анализировать переходные процессы. Если же на схеме разместить анализатор частотных характеристик, то будет рассчитан режим по постоянному току, выполнена линеаризация нелинейных компонентов и затем проведен расчет характеристик схемы в частотной области. Диапазон анализируемых частот, коэффициент усиления и характер оцифровки данных (в линейном или логарифмическом масштабе) устанавливают на лицевой панели с помощью мыши.


Чтобы начать моделирование, достаточно щелкнуть на переключателе, расположенном в верхнем правом углу экрана. После этого на устройствах индикации цифровых вольтметров и амперметров будет зафиксирован режим по постоянному току, на экране измерителя нарисованы частотные характеристики (амплитудно- или фазочастотные), а на экране осциллографа будут непрерывно изображаться эпюры напряжений до тех пор, пока не заполнится буферная память, а затем можно прекратить моделирование или обнулить память и продолжить наблюдения. 


Ниже приведены характерные особенности программы Electronics Workbench. 


1) Схема изображается в графическом виде привычным образом. Из горизонтально расположенного меню выбирают библиотеку компонентов, состав которой изображается слева от рабочего экрана. Движением мыши символы компонентов  переносят на схемы и выполняют электрические соединения. Достаточно указать начальный и конечный вывод цепи, как цепь будет проложена автоматически (правда, не всегда удачно, так что ее приходится немножко корректировать). 


2) Полностью поддерживается текстовый формат программы моделирования SPICE, причем при загрузке текстового файла в формате SPICE на экране будет нарисована принципиальная схема с подключенными измерительными приборами (топология сложных схем синтезируется не вполне удачно, но моделируются такие схемы без ошибок). 


3) Предусмотрен вывод списка соединений в формате программы OrCAD PCB (в файлах с расширением имени .NET) для разработки печатных плат. 


4) Поддерживается стандартный набор компонентов: резисторы, конденсаторы, индуктивности, управляемые линейные и нелинейные источники, линии задержки без потерь и с потерями, диоды, тиристоры, различные транзисторы, операционные усилители, цифровые интегральные схемы и др., а также светодиоды, цифровые индикаторы, резистивные матрицы, плавкие предохранители, лампочки накаливания и ключи. Имеется механизм создания макромоделей. 
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Рис.2.1 Экран Electronics Workbench.


5) Предусмотрена возможность изменения параметров компонентов нажатием клавиш. Есть кнопочные переключатели, управляемые с клавиатуры. При этом параметры можно изменять, не прерывая моделирования, как в реальном эксперименте. 


6) Имеются следующие измерительные приборы: мультиметры (измерения постоянного и переменного напряжения и тока, сопротивления, результаты выводятся в относительных единицах и децибелах); двухлучевые осциллографы (регулируются усиления каналов, частота развертки, смещение лучей по координатам X, Y, имеются открытый и закрытый входы, предусмотрен ввод сигналов синхронизации); измерители частотных характеристик (Bode Plotter); генератор цифровых сигналов (Word Generator); цифровой логический анализатор и логический преобразователь. На схеме можно разместить только по одному из приборов каждого типа. При развертывании изображения лицевой панели прибора на весь экран с помощью двух электронных курсоров проводят точные измерения характеристик. 


7) Различные цепи можно окрашивать в разные цвета для улучшения восприятия схемы. При этом временные диаграммы на экране двухлучевого осциллографа и многоканального логического анализатора окрашиваются в те же цвета.


8) Возможен ввод дискретных отсчетов сигналов из файлов. 


9) На периферийные устройства можно вывести принципиальную схему, ее текстовое описание, перечень компонентов.


 Для измерительных инструментов рисуется лицевая панель с изображением характеристик и положением органов управления, а для осциллографа изображаются также эпюры напряжений неограниченной длины. 





Интерфейс Electronics Workbench


Как видно из рис.2.1. интерфейс Electronics Workbench по своему построению очень похож на стандартный интерфейс Windows. 


Прежде чем создавать чертеж принципиальной схемы средствами программы EWB, необходимо на листе бумаги подготовить ее эскиз с примерным расположением компонентов и с учетом возможности оформления отдельных фрагментов в виде подсхем. Целесообразно также ознакомиться с библиотекой готовых схем программы для выбора аналога (прототипа) или использования имеющихся решений в качестве подсхем.


В общем случае процесс создания схемы начинается с размещением на рабочем поле EWB компонентов из библиотек программы в соответствии с подготовленным эскизом. Одиннадцать разделов библиотеки программы EBW поочередно могут быть вызваны с помощью меню Window или с помощью иконок, расположенные под линейкой контрольно-измерительных приборов (см. рис. 2.1). Описать процесс вызова схемы из библиотеки.


Вывести схему на рабочее поле Electronics Workbench можно 2-мя способами:


- 1-й способ - вызов готовой схемы из библиотеки. Делается это посредством команды Open из меню File. 


Библиотека схем Samples находится в каталоге Wbnch. Она содержит файлы со схемами как в своём корневом каталоге, так и в двух подкаталогах Complex и Tutorial. Расширение файлов содержащих схемы - ewb. 


- 2-й способ создание схемы вручную посредством встроенного графического редактора. Этот способ начинается с выбора команды New из меню File. После этой команды рабочее поле очищается и можно приступать к созданию схемы.


Вынос элементов схемы и измерительных приборов:


- навести стрелку на прибор или элемент;


- нажать левую кнопку “мыши” и удерживая её переместить объект на рабочее поле (выделение снимается нажатием правой кнопки “мыши” и производится двойной щелчок по значку компонента. В раскрывающемся диалоговом окне устанавливаются требуемые параметры (сопротивление резистора, тип транзистора и т.д.) и выбор подтверждается нажатием кнопки Accept или клавиши Enter. На этом этапе необходимо предусмотреть место для размещения контрольных точек и иконок контрольно-измерительных приборов.


- Если в схеме используются компоненты одинакового номинала (например, резисторы с одинаковым сопротивлением), то номинал такого компонента рекомендуется задать непосредственно в каталоге библиотеки и затем переносить компоненты в нужном количестве на рабочее поле. Для изменения номинала компонента необходимо два раза щелкнуть мышью по символу его графического изображения и в раскрывающемся после этого окне внести изменения.


Соединения между элементами на рабочем поле выполняются следующим образом:


- установить стрелку на окончание нужного вам вывода элемента:


- нажать левую кнопку “мыши” (на окончании выбранного вывода должна появится крупная чёрная точка) и удерживая её двигать стрелку по направлению к предназначенному для соединения другому выводу (при этом за стрелкой будет тянуться линия);


- навести стрелку на нужный вывод, при этом на нём появится чёрная точка (это означает что соединение установлено) и отпустить кнопку “мыши” на рабочем поле должно появится соединение.


- Чтобы точка почернела (первоначально она имеет красный цвет), необходимо щелкнуть мышью по свободному месту рабочего пол. Если эта точка действительно имеет электрическое соединение с проводником, то она полностью окрашивается черным цветом. Если на ней виден след от пересекающего проводника, то электрического соединения нет и точку необходимо установить заново. После удачной установки к точке соединения можно подключить еще два проводника. Если соединение нужно разорвать, курсор подводится к одному из выводов компонентов или точке соединения и при появления площадки нажимается левая кнопка, проводник отводится на свободное место рабочего пол, после чего кнопка отпускается. Если необходимо подключить вывод к имеющемуся на схеме проводнику, то проводник от вывода компонента курсором подводится к указанному проводнику и после появления точки соединения кнопка мыши отпускается. Следует отметить, что прокладка соединительных проводников производится автоматически, причем препятствия — компоненты и другие проводники — огибаются по ортогональным направлениям (по горизонтали или вертикали).


- Точка соединения может быть использована не только для подключения проводников, но и для введения надписей (например, указания величины тока в проводке, его функционального назначения и т.п.). Для этого необходимо дважды щелкнуть по точке и в раскрывшемся окне ввести необходимую запись (не более 14 символов), причем запись можно смещать вправо путем введения слева нужного количества пробелов. Это свойство может быть использовано и в том случае, когда позиционное обозначение компонента (например C1, R10) накладывается на рядом проходящий проводник или другие элементы схемы.


- Если необходимо переместить отдельный сегмент проводника, к нему подводится курсор, нажимается левая кнопка и после появления в вертикальной или горизонтальной плоскости двойного курсора производится нужные перемещения.


Само соединение можно подкорректировать - навести стрелку на линию соединения нажать левую кнопку “мыши” и удерживая её перемещать линию в нужном направлении.


Точная корректировка элементов, приборов и узлов на рабочем поле:


- навести стрелку на объект;


- нажатием правой кнопки “мыши” выделить его;


- корректировать положение клавишами управления курсором.


- Причем для таких приборов, как осциллограф или логический анализатор, соединения целесообразно проводить цветными проводниками, поскольку их цвет определяет цвет соответствующей осциллограммы. Цветные проводники целесообразны не только для обозначения проводников одинакового функционального назначения, но и для проводников, находящихся в разных частях схемы (например, проводники шины данных до и после буферного элемента). Примеры такого оформления можно найти в каталогах готовых схем (см. файл adc-dacl.ca4).


- При обозначении компонентов необходимо придерживаться рекомендаций правил, предусмотренных ЕСКД (единой системой конструкторской документами). Что касается пассивных компонентов, то при выборе их обозначений особых трудностей не возникает. Трудности возникают при выборе активных элементов — микросхем, транзисторов и т.п., особенно при необходимости использования компонентов отечественного производства, когда требуется установить точное соответствие функциональных обозначений выводов и параметров зарубежных Отечественных компонентов. Для облегчения этой задачи можно воспользоваться таблицами соответствия зарубежных и отечественных компонентов.


- При импортировании в создаваемую схему другой схемы или ее фрагментов целесообразно действовать в следующей последовательности:


Командой File>Save As записать в файл создаваемую схему, указав его им в диалоговом окне (расширение имени файла указывать не обязательно, программа сделает это автоматически);


Командой File>Open загрузить на рабочее поле импортируемую схему стандартным для Windows образом; 


Командой Edit>Select All выделить схему, если импортируется вся схема, или выделить ее нужную часть;


командой Edit>Copy скопировать выделенную схему в буфер обмена; 


командой File>Open загрузить создаваемую схему;


командой Edit>Paste вставить содержимое буфера обмена на рабочее поле; вставки импортируема схема будет выделена (и отмечена красным цветом) и может оказаться наложенной на создаваемую схему; 


клавишами управления курсором (или ухватившись мышью за один из компонентов) отбуксируйте импортированную часть в нужное место, после чего можно отменить выделение;


после подключения импортированной схемы необходимо щелчками мыши пройтись по всем ее компонентам, чтобы исключить их смещения, возникающей при буксировке и приводящие к ступенчатым искажениям проводников.


Перемещения отдельных фрагментов схемы при ее компоновке выполнения вышеописанным образом после выделения фрагмента. Если схема состоит из однотипных блоков, то целесообразно скомпоновать один такой блок, а затем путем копирования и вставки размножить его до нужного количества и выполнить необходимые соединения.


После подготовки схемы рекомендуется составить ее описание (окно-ярлык вызывается из меню Window>Description), в котором указывается ее назначения после проведения моделирования указываются его результаты. К сожалению, программа EWB позволяет вводить описание только на английском языке. Кроме в EWB не предусмотрены средства для редактирования графических изображений компонентов, а также введения новых шрифтов (в EWB 4.1).





Верхняя строка экрана Electronics Workbench (см.рис.2.1):





Меню File:


New�
- создать новый файл, файл для создания, описания и моделирования новой схемы;�
�
Open�
- открыть уже созданный файл (созданный в Electronics Workbench);�
�
Save�
- сохранить текущий (открытый) файл с текущим именем в текущую директорию;�
�
Save as�
- сохранить текущий файл предварительно введя имя и путь для сохранения;�
�
Revert to saved�
- вернуться к сохранённому файлу;�
�
Print�
- распечатать текущую схему, причём после выбора этого пункта меню предоставляется возможность выбора, что именно нужно распечатать: схемные параметры- схемотехника, описание схемы, листинг составляющих схемы, листинг моделей и т.д., инструментарий- мультиметр, функциональный генератор, осциллограф и т.д.;�
�
Print Setup�
- доступ к установке принтеров (через Windows Setup для принтеров);�
�
Exit�
- выход из Electronics Workbench;�
�
Import from SPICE�
- импортировать из SPICE какую-либо схему, причём импортируемая схема сразу же конвертируется из формата SPICE (описания) в графический вид и выводится на экран;�
�
Export to SPICE�
- отправить в SPICE текущую схему, причём она сразу же конвертируется в формат SPICE;�
�
Export to PCB�
- отправить в PCB текущую схему;�
�



Меню Edit:


Cut�
- вырезать выделенные компоненты, затем их можно вставить в любую схему в пределах среды Electronics Workbench (см. команда Paste) выделение производится следующим образом - сначала стрелка(указатель положения курсора) устанавливается в выбранное место на схеме, затем следует нажать левую клавишу “мыши” и удерживая её растянуть появившуюся рамку на компоненты схемы которые нужно выделить, после отпустить клавишу, выделенные компоненты будут окрашены в красный цвет; ещё один способ выделения отдельных компонентов схемы состоит в следующем: навести стрелку на тот компонент, который хотите выделить и нажать на правую кнопку “мыши” - таким образом можно выделять или убирать выделение с отдельных компонентов не нарушая выделение других;�
�
Copy�
- копировать выделенные компоненты схемы;�
�
Paste�
- вставить, эта команда становится доступной только после выполнения команд Cut или Copy; после выбора этой команды копируемый или вырезанный компонент или фрагмент схемы всегда появляются в центре видимой части рабочего поля;�
�
Delete�
- удалить выделенный элемент или фрагмент схемы;�
�
Select All�
- выбрать всё, эта команда позволяет выбрать сразу всю схему;�
�
Copybits�
- копирование в буфер обмена Windows; используется для переноса эл. схем, результатов исследований, осциллограмм и т.д. в другие приложения Windows (например в Word); после выбора этой команды на рабочем поле Electronics Workbench вместо стрелки появится крестик, его нужно установить в выбранное место рабочего поля затем нажать левую кнопку “мыши” и растянуть рамку на ту часть рабочего поля, которая предназначена для копирования после отпускания кнопки “мыши” выбранное изображение рабочего поля будет записано в буфер обмена; вставка в другом приложении производится командой Вставить(Paste)�
�
Show Clipboard�
- просмотр содержимого буфера обмена;�
�
Copy as Bitmap�
- команда копирования экрана�
�



Меню Circuit:


Activate�
- активация находящейся на рабочем поле схемы(начать процесс моделирования); эта команда аналогична нажатию посредством “мыши” виртуального выключателя в правом верхнем углу рабочего поля  Electronics Workbench;�
�
Stop�
- полная остановка процесса моделирования; аналогична выключению виртуального выключателя “мышью”;�
�
Pause�
- временная остановка процесса моделирования с сохранением всех промежуточных результатов, т.е. после повторного нажатия Pause процесс моделирования продолжается точно с точки прерывания;�
�
Label�
- установить (изменить) обозначение выбранного элемента; команда становится доступной лишь после того, как на схеме выбран элемент;�
�
Value�
- установить (изменить) номинал выбранного элемента схемы;�
�
Model�
- присвоить выбранному элементу схемы параметры реально существующего элемента или идеального; после выбора этой команды появляется меню, где можно выбрать из базы данных Electronics Workbench тип элемента с последующей возможностью редактирования его параметров;�
�
Zoom�
- устанавливает количество входов элемента или в некоторых случаях действует аналогично команде Model;�
�
Rotate�
- поворачивает выбранный элемент на 90 градусов по часовой стрелке;�
�
Fault�
- устанавливает неисправность выбранного элемента,  можно задать: утечку, короткое замыкание и обрыв;�
�
Subcircuit�
- объединяет выделенные элементы схемы в подсхему и помещает её (полученную подсхему) под выбранным именем в окно Custom;�
�
Wire color�
- задаёт цвет выделенного провода;


выделение провода: навести стрелку на нужный провод и один раз нажать левую кнопку “мыши”;�
�
Preferences�
- устанавливает параметры изображения схемы: сетка рабочего поля, условное обозначение элементов, названия моделей элементов, номинал элементов;�
�
Analysis options�
- устанавливает опции анализа схемы: переходные процессы или установившийся режим, симуляция активных компонентов, режим изображения экрана осциллографа, погрешность моделирования, частота временных точек, где происходит моделирование на цикл моделирования, частота точек боде анализа(ФАПЧХ) на цикл моделирования, размер временного файла для моделирования;�
�



Меню Window:


Arrange�
- устанавливает стандартный вид экрана Electronics Workbench;�
�
Circuit�
- устанавливает режим изображения схемы;�
�
Description�
- открывает окно для примечаний к текущей схеме;�
�



Меню Analysis:


Activate�
- активация находящейся на рабочем поле схемы(начать процесс моделирования); эта команда аналогична нажатию посредством “мыши” виртуального выключателя в правом верхнем углу рабочего поля Electronics Workbench;�
�
Stop�
- полная остановка процесса моделирования; аналогична выключению виртуального выключателя “мышью”;�
�
Pause�
- временная остановка процесса моделирования с сохранением всех промежуточных результатов, т.е. после повторного нажатия Pause процесс моделирования продолжается точно с точки прерывания;�
�
Analysis Options…�
Набор команд для установки параметров моделирования�
�
Global�
Настройки общего характера; задаются в диалоговом окне, в котором параметры могут иметь различные значения�
�
DC�
Настройки для расчета режима по постоянному току (статический режим).�
�
Transient�
Настройка параметров режима анализа переходных процессов�
�
Device�
Выбор параметров МОП- транзисторов�
�
Instruments�
Настройка параметров контрольно-измерительных приборов�
�
DC Operating Point�
Расчет режима по постоянному току; в этом режиме из моделируемой схемы исключается все конденсаторы (обрыв цепи) и закорачиваются все индуктивности.�
�
DC Sweep…�
Вариация параметров используемых в моделируемой схеме источников при расчете режима по постоянному току.�
�
AC Frequency…�
Расчет частотных характеристик�
�
Fourrier…�
Проведение Фурье-анализа (спектрального анализа).�
�
Noise…�
Анализ спектра внутренних шумов�
�
Distortion�
Анализ нелинейных и интермодуляционных искажений�
�
Parametr sweep…�
Вариация параметров�
�
Temperature sweep…�
Температурные испытания моделируемой схемы�
�
Pole-Zero...�
Расчет карты нулей и плюсов передаточной характеристики моделируемой схемы�
�
Sensitivity…�
Расчет относительной чувствительности  характеристик схемы к изменениям параметров выбранного компонента при частотном анализе (АС) или при расчете статистического режима (DC)�
�
Worst Case…�
Расчет значений параметров компонентов схемы в режиме DC или АС при предельных отклонениях ее характеристик�
�
Monte Carlo…�
Статистический анализ по методу Монте-Карло�
�
Display Graph�
Этой командой вызывается на экран графики результатов выполнения одной из команд моделирования.�
�



Панель универсальных измерительных приборов:


�        - мультиметр;


�       - функциональный генератор;


�     - осциллограф;


�   - боде плоттер (измеритель ФАПЧХ);


�- генератор слов;


�   - логический анализатор;


�- логический конвертор.





Логический (цифровой) конвертор.


�


Рис.2.2 Внешний вид панели управления логического (цифрового конвертора).


Логический конвертор является мощным компьютерным прибором способным проводить несколько трансформаций схемных представлений.


Вы можете использовать его для преобразования:


- схемы в таблицу истинности;


- таблицу истинности в выражение булевой логики;


- выражение булевой логики в схему или таблицу истинности с промежуточной минимизацией.


Управление логическим конвертором.


В правой части панели управления логического конвертора (см. рис.2.2) расположены конверсионные кнопки, которые можно использовать для выполнения следующих операций:


1) Конвертирование схемы в таблицу истинности.


Логический конвертор может создавать таблицу истинности для схемы с не более чем 8-ю входами и одним выходом. Для этого следует выполнить следующие действия:


- подсоединить схемные входы к выводам в верхней части панели управления логического конвертора (следует использовать левые 8 выводов). Затем подсоединить схемный выход к правому выводу в верхней части панели управления;


- Чтобы получить таблицу истинности на дисплее панели управления, расположенном слева от кнопок, следует “нажать” стрелкой (навести стрелку и нажать левую кнопку “мыши”) виртуальную кнопку:


�


Далее можно редактировать или конвертировать таблицу истинности в другие формы используя остальные кнопки логического конвертора.


2) Ввод таблицы истинности.


Для создания таблицы истинности следует стрелкой и нажатием левой кнопки “мыши” выбрать желаемые вводы (каналы) логического конвертора от A до H, расположенные над дисплеем. Затем в столбце OUT присвоить желаемым разрядам 1, 0 или X тем же способом, что и побитный ввод слов в генераторе слов.


3) Конвертирование таблицы истинности в выражение булевой логики.


Чтобы конвертировать таблицу истинности, имеющуюся на дисплее логического конвертора, в выражение булевой логики следует “нажать” стрелкой на кнопку:


�


Булево выражение появится внизу в окошке под дисплеем и кнопками. Его можно затем упростить (см. 4)Упрощение булева выражения) или конвертировать в схему (см. 6) Конвертация булева выражения в схему).


4) Упрощение (минимизация) булева выражения. Конвертирование таблицы истинности в минимизированное булево выражение.


Чтобы минимизировать имеющееся в окошке под дисплеем и кнопками булево выражение или перевести, расположенную на дисплее панели управления, таблицу истинности в минимизированное булево выражение следует “нажать” стрелкой кнопку:


�


Electronics Workbench использует метод Квайна-Мак Класки для минимизации булевых выражений. Этот способ обеспечивает упрощение для систем с большим числом входов, чем может быть расчитано вручную с помощью карт Карно.


Примечание: Упрощение требует много памяти (ОЗУ). Если ваш компьютер не имеет достаточно памяти, эта операция не будет вам доступна.


5) Конвертация булева выражения в таблицу истинности.


Булево выражение можно напрямую ввести в окошко предназначенное для него. Т.е. с помощью “мыши” установить туда курсор и набрать выражение с клавиатуры (доступны будут лишь те клавиши, которые имеют смысл в этом выражении), либо получить с помощью предыдущих операций.


Для конвертации булева выражения в таблицу истинности следует “нажать” стрелкой на кнопку:


�


Если вы хотите минимизировать булево выражение его следует сначала перевести в таблицу истинности.


6) Конвертация булева выражения в схему.


Чтобы выполнить эту операцию(при имеющемся в окошке панели управления булевом выражении) следует “нажать” стрелкой на кнопку:


�


Схема реализованная на логических ключах появится на рабочем столе Electronics Workbench. Компоненты будут в режиме выделения, поэтому их при необходимости можно будет легко перенести в другое место копированием(Copy), вставкой(Paste) или вставкой в подсхему(Subcircuit), (см. соответствующие команды Copy, Paste и Subcircuit).


Для построения схемы в этом случае будет использован базис: И, ИЛИ, НЕ. Если же требуется построить схему в базисе только И-НЕ см.ниже.


7) Конвертация булева выражения в схему в базисе И-НЕ.


Для выполнения этой операции (при имеющемся в окошке булевом выражении) следует “нажать” стрелкой кнопку:


�





Порядок выполнения


Элемент НЕ-И. 


1. Запустим Electronics Workbench, щелкнув по ярлыку, расположенного на рабочем столе.�


2. Щелкнем по кнопке �


3. Выберем логический элемент НЕ-И � и поместим (перенесем) на рабочее поле


4. �- Выберем панель универсальных измерительных приборов


5. Выберем логический конвертор �.


6. Соединим логический элемент с логически конвертером - линиями, как описано выше.


�


7. Дважды щелкнем по значку логического конвертора, а затем по кнопке � и получим: 





�


В крайне правом столбце получим таблицу истинности. Сравните с таблицей 3.2.


Запустим программу - калькулятор LogiTable. Вычислим НЕ-И, заметим, что логические операции выглядят иначе, Чем предыдущей программе. Таблица истинности одинакова, у обоих программ.


�





Элемент И. 


1. Запустим Electronics Workbench, щелкнув по ярлыку, расположенного на рабочем столе.�


2. Щелкнем по кнопке �


3. Выберем логический элемент И � и поместим (перенесем) на рабочее поле


4. �- Выберем панель универсальных измерительных приборов


5. Выберем логический конвертор �.


6. Соединим логический элемент с логически конвертером - линиями, как описано выше.


�


7. Дважды щелкнем по значку логического конвертора, а затем по кнопке � и получим: 


�


В крайне правом столбце получим таблицу истинности. Сравните с таблицей 3.2.


Запустим программу - калькулятор LogiTable. Вычислим И, заметим, что логические операции выглядят иначе, Чем предыдущей программе. Таблица истинности одинакова, у обоих программ.


�


Элемент ИЛИ. 


1. Запустим Electronics Workbench, щелкнув по ярлыку, расположенного на рабочем столе.�


2. Щелкнем по кнопке � и Выберем логический элемент ИЛИ � и поместим (перенесем) на рабочее поле





3. �- Выберем панель универсальных измерительных приборов


4. Выберем логический конвертор �.


5. Соединим логический элемент с логически конвертером - линиями, как описано выше.


�





6. Дважды щелкнем по значку логического конвертора, а затем по кнопке � и получим: 


�


В крайне правом столбце получим таблицу истинности. Сравните с таблицей 3.2.


Запустим программу - калькулятор LogiTable. Вычислим ИЛИ, заметим, что логические операции выглядят иначе, Чем предыдущей программе. Таблица истинности одинакова, у обоих программ.


�


Проверить самостоятельно остальные логические элементы, (см. табл.3.2. [4]).

















Контрольные вопросы и задания


1. Известно, что единицей измерения информации является бит. Какие значения может принимать эта единица?


2. Что является математической основой применения логических элементов?


3. Какое общее название имеют устройства на базе логических элементов?


4. Какие логические элементы принято считать основными и какими булевыми выражениями они описываются?


5. Перечислите основные законы булевой алгебры.


6. Что такое положительная и отрицательная логика и на каком законе при этом основывается взаимное преобразование логических элементов? 


7. Проведите моделирование оставшихся без рассмотрения двухвходовых логических элементов с использованием логического преобразователя и установите для каждого из них соответствие таблицы истинности и булева выражения.


8. Разработайте схемы электромеханических имитаторов двухвходовых логических элементов (за исключением элемента И).


9. Проведите синтез трехвходового логического устройства с выходной комбинацией 10011110 в таблице истинности.


10. Проведите проверку основных аксиом и законов булевой алгебры.


11. Установите различия в булевых выражениях и графических обозначений логических элементов программы EWB от принятых в отечественной научно-технической литературе.


Проведите испытания ИМС 7400 (155ЛАЗ, 4 элемента 2И-НЕ), 7432 (155ЛЛ1, 4 элемента 2ИЛИ) и 7486 (155ЛП5, 4 элемента ИСКЛЮЧАЮЩЕЕ ИЛИ). Входы в этих ИМС обозначаются буквами А, В; выход — Y.
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